In this short tutorial we will explore how to use SALT Software to analyze a language sample. There will be a demonstration of the various reports generated from the Analyze and Database menus.

For demonstration purposes, we will use a language sample from a third grade student, Cyanna. Cyanna has been seen in speech therapy for three years. She has been working on articulation and expressive/receptive language skills. As you can see from the transcript header information, she is eight years, seven months old and is in the 3rd grade. This is a conversational sample between Cyanna and an examiner. Cyanna uses African American English (AAE) dialect. Notice that the codes used in the transcript are listed here in the header.

Our general process for analyzing a language sample is to start with the transcript summary. The transcript summary is just that, a summary of the utterances within the language sample. Select transcript summary from the analyze menu. Keep in mind that all of the reports generated from the analyze menu are raw numbers from your language sample. There is not a database comparison for any of the analyze menu reports.
Here you can see the transcript summary. Notice that there are two sets of information on this report. The first is based on total utterances, so this includes all the utterances in the transcript. The second half of the report presents the same information but based on the analysis set. In this example we are using the default analysis set which consists of the complete and intelligible, verbal utterances. This excludes nonverbal utterances, utterances with unintelligible segments, and those utterances that were abandoned or interrupted.

We have information such as utterance type (questions, statements, exclamations, abandoned and interrupted and so forth). This information is listed for both the target speaker (child in this case) and the examiner. Take a minute to look at this summary. Did the child produce a sufficient number of utterances? Did the examiner ask too many questions? And if the examiner did ask a lot of questions, did they result in a lot of yes/no responses which would lower the child's MLU?

Notice that Cyanna abandoned 6 utterances and 7 of her utterances were interrupted by the examiner. We will look at these utterances a little later.

Once we have determined that the sample is adequate and the examiner did not negatively influence the sample we can move on with our analysis.

<table>
<thead>
<tr>
<th>TOTAL U TTERANCES</th>
<th>CHILD</th>
<th>EXAMINER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>number</td>
<td>percent</td>
</tr>
<tr>
<td>Statements (-)</td>
<td>93</td>
<td>82.21</td>
</tr>
<tr>
<td>Declarations (-)</td>
<td>0</td>
<td>...</td>
</tr>
<tr>
<td>Questions (?)</td>
<td>7</td>
<td>6.06</td>
</tr>
<tr>
<td>Int nondem.Prompts (-)</td>
<td>0</td>
<td>...</td>
</tr>
<tr>
<td>Abandoned Utterances (-)</td>
<td>6</td>
<td>5.22</td>
</tr>
<tr>
<td>Interrupted Utterances (-)</td>
<td>7</td>
<td>6.06</td>
</tr>
<tr>
<td>Verbal Utterances</td>
<td>114</td>
<td>99.13</td>
</tr>
<tr>
<td>Nonverbal Utterances</td>
<td>1</td>
<td>0.87</td>
</tr>
<tr>
<td>Unintelligible Utterances</td>
<td>1</td>
<td>0.87</td>
</tr>
<tr>
<td>Partially intelligible Utterances</td>
<td>1</td>
<td>0.87</td>
</tr>
<tr>
<td>Responses to Questions</td>
<td>22</td>
<td>20.00</td>
</tr>
<tr>
<td>Yes/No responses to Questions</td>
<td>7</td>
<td>6.06</td>
</tr>
<tr>
<td>Questions in Interviews</td>
<td>0</td>
<td>...</td>
</tr>
<tr>
<td>Interruptions</td>
<td>2</td>
<td>1.74</td>
</tr>
<tr>
<td>One word Utterances</td>
<td>22</td>
<td>19.72</td>
</tr>
<tr>
<td>Utterances with Names</td>
<td>59</td>
<td>50.92</td>
</tr>
<tr>
<td>Utterances with Passes</td>
<td>10</td>
<td>9.09</td>
</tr>
<tr>
<td>Utterances with Omissions</td>
<td>0</td>
<td>...</td>
</tr>
<tr>
<td>Utterances with Overlapping Speech</td>
<td>17</td>
<td>14.76</td>
</tr>
<tr>
<td>Utterances with Word Codes</td>
<td>7</td>
<td>6.06</td>
</tr>
<tr>
<td>Utterances with Utterance Codes</td>
<td>17</td>
<td>15.76</td>
</tr>
<tr>
<td>ANALYSIS SET (-ED Verbal Utter)</td>
<td>100</td>
<td>...</td>
</tr>
<tr>
<td>Statements (-)</td>
<td>93</td>
<td>93.92</td>
</tr>
<tr>
<td>Declarations (-)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Questions (?)</td>
<td>7</td>
<td>7.00</td>
</tr>
<tr>
<td>Int nondem.Prompts (-)</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
But, before we do, let’s take a minute to look at the context help available within the software.

From the Help menu, select “Context Help”.

Context help provides help on the current report - in this case, the Transcript Summary report. All the variables included in this report are defined.

Let’s close this help window and continue analyzing Cyanna’s sample.
Next we are going to the database menu where Cyanna’s sample can be compared with age or grade-matched database samples. Select the Standard Measures report.

You are presented with the “database comparison set” dialogue box where you define the comparison options including which samples to use for comparison.

The default settings are useful since they are based on the information you entered in the transcript header. But you still need to use your clinical judgment here to make sure that the comparison set is appropriate.

In the first box you select the appropriate database for comparison. Because the transcript header indicated that this is a conversational sample, the Conversation database is pre-selected. If you need to select a different database, you can change it here.

There is also a button in this section labeled “database snapshot” where you can view a description of the selected database.

Next you can select to whom you want to compare your sample. Usually, you want to compare your sample to a set of age-matched peers. You have the option to stretch or reduce the age match range for your comparison. As a rule of thumb, we want at least 20 database participants to use for comparison. You may need to stretch out the age range, or conversely, if you have a lot
of matching participants, you may want to reduce the age range to get a closer age match. There is also the option to compare your sample based on grade, gender, and/or parent education, as well as any combination of these options.

The next decision to be made is what to base your comparison on. There is the option to base your comparison on the entire transcript. You might select this for a story retell or an expository sample where there is a specific structure to the narrative. You would not want to select the entire transcript, however, for an open-ended sample such as a conversation. Instead, you would compare your sample to those with the same number of words, utterances, or time. For this example, we will keep the default setting and base the comparison on the same number of words.

When you base your comparison on the same number of words, you also need to specify which words you are including. First you select the utterance base, words found either in the analysis set utterances or in all utterances. The default is set at “analysis set” so this means, utterances that are complete, intelligible and verbal. However, you can select total utterances if you would like. We will use the default here.

When determining which words on which to base the comparison, you also need to specify the “word area.” Here you select if you want to count only the main body words or if you want to count the words in mazes as well. We will keep the default setting and only count words in the main body of the utterances. You should note that the number of main body words within the analysis set is the same as the “number of total words” or NTW. Cyanna has 666 NTW.

Once you are happy with your comparison selection, click OK.
We can see that there are 43 participants in the comparison set that have at least 666 NTW.

This seems like a reasonable comparison since we are well over 20 comparison participants. Now we have the database comparison set selected and can go ahead and compare our sample to the database using this comparison set.

So we'll go ahead and click OK here.

This dialog box confirms your database comparison selections. Click OK.
SALT calculates the database comparison measures and, within a matter of seconds, the standard measures report is displayed. You can think of the standard measures report as the cover sheet of your transcript. It gives you general information about several domains of oral language. We’ll spend a little bit of time here going through this report so you have a good understanding. In general, the report gives you information on the target speaker and the database comparison information. At the top of the report is the information from your transcript such as speaker, sample date, context - and then information is given about the database comparison including participants, age range, context etcetera. Notice that Cyanna’s sample and the database samples have 666 “number of total words” or NTW. The 43 database samples have all been cut at 666 NTW to match the length of Cyanna’s sample.

If we look at the left hand side of this report we can see the language measures, tran length and syntax/morphology headings. The next columns give information on the target speaker, the score and the standard deviation plus or minus from the database mean. If we jump over to the next section we see the database numbers. The mean, minimum, maximum, and standard deviation values are listed here along with the % standard deviation. The percent standard deviation calculates how close together the data values are. The larger the value, the more spread apart the data values. Some measures, such as pauses and mazes, will have more variability because some participants pause and maze a lot while others rarely do so.

As you look at this report, notice that some of the child’s scores are shaded and followed by one or two asterisks. Measures that are one standard deviation above or below the database mean are marked with one asterisk. Two asterisks indicate measures that are two or more standard deviations above or below the mean.
The standard deviation interval can be changed from within the database menu to fit your measurement criteria.

The first section of the standard measures report provides information about the transcript length in terms of utterances, words, and elapsed time. We can see that Cyanna used significantly more words and more time to produce the 666 NTW than her age-matched peers.

Next there is information on syntax and morphology which gives you MLU in words and morphemes. We can see that Cyanna had an MLU of 7.01 in morphemes, which is .15 SD above the mean. So, in other words, within age-expected range.

Semantic measures are represented by number of different words, number of total words and type token ratio. We can see that Cyanna used 164 different words within the 666 number of total words her sample is based on. This measure is well below the database mean of 225.98. Actually, it’s 4.52 SD below the mean. Her type token ratio is also below the database mean. Type token ratio is the number of different words divided by number of total words. Type token ratio is a general indicator of lexical diversity within a text. However, number of different words may be a more sensitive indicator of overall lexical variety.
The next section gives us information about discourse. This, of course, is most applicable to conversational samples. The discourse values include percent response to questions, mean turn length, utterances with overlapping speech, and interruptions. For the most part, we can see that Cyanna did well with discourse. She interrupted the examiner three times.

Intelligibility is listed next in the standard measures report. This is a very gross measure of intelligibility. All utterances with any unintelligible segments are counted as unintelligible. This is listed as percent utterances that are intelligible.

Further down in the report mazes and abandoned utterances are listed. Mazes are defined as filled pauses, false starts or part words, repetitions, and revisions. In Cyanna’s case we can see that she had 33 utterances with mazes consisting of 57 total mazes. The next measure is the number of maze words. The maze words as a percentage of total words is also listed. We can see that 18% of Cyanna’s total words were contained in a maze. This, along with her number of maze words, are well database mean at 2.14 SD and 2.25 SD. So Cyanna produced more false starts, repetitions and revisions than her age-match peers. We will take a closer look at Cyanna’s mazes in another report later on.

Abandoned utterances are those where the speaker begins to talk, but does not finish the utterance to completion. Cyanna’s language sample contained 6 abandoned utterances which is .45 SD above the database mean.
Next in this report are measures of Verbal facility and rate. These are calculated based on the amount of elapsed time of the language sample and on the silent pauses within the sample. If you are interested in verbal facility and rate measures, during transcription, you must include the start and end times of the language sample and mark pause times where they occur within and between the utterances. The measures SALT calculates include words per minute, within-utterance pauses (this is the number of pauses), within utterance pause time (this is pause time in minutes). Between-utterance pauses and pause time are also listed. If we look at these measures, we see Cyanna used a lot of pauses; 12, for a total of .72 minutes during her sample. Both of these measures are marked with two asterisks shaded squares as they are more than 2 SD above the database mean, indicating that Cyanna spent more time pausing than her age-matched peers. This might be an area we want to look at in more detail.

The final section on the standard measures report is the omissions and error codes. The number of omitted words and bound morphemes are listed here. We can see that Cyanna did not have any omitted words in her language sample. Now notice that this measure is marked with one asterisk show shaded squares as typical age-match peers actually have more omissions than Cyanna. I point this out to illustrate that you must use caution when looking at measures with asterisks as they may indicate an area of strength rather than an area of challenge. The absence of omitted words and bound morphemes is a strength for Cyanna.

Word and utterance level codes are listed next. Cyanna had 5 word-level error codes and 5 utterance-level error codes. Error codes begin with an “E” and are inserted in the transcript to mark words and utterances when an error occurs for which there is no standard convention. This allows these words and utterances to be counted here and examined in more detail in other reports.
Now we are done with the Standard measures report. You might note, under the “File” menu you have the option of saving or printing the transcript and any of the reports you’ve generated in SALT.

Now, let’s close this report…
Let's go back to the database menu.
Select the maze summary since we noted on the standard measures report that Cyanna's language sample had a lot of mazes and we want to explore those mazes in more detail. We might be thinking that she has difficulty with word retrieval or perhaps with utterance formulation based on what we saw in the Standard Measures Report.

…and take a look at some additional reports based on what we saw on the standard measures report.
Here we see the maze summary show title. Because this analysis is generated from the database menu, we have a database comparison set for this report. Just as we saw with the standard measures report, the target speaker information is on the left and the database information is on the right.

The maze summary provides a breakdown of the mazes in more detail and gives a better idea of where and what type of mazes the speaker produced.

The first section of the maze summary shows the same information that was on the standard measures report; utterances with mazes, number of mazes, number of maze words and percent maze words.

The next section of the report provides data for each type of maze found within the transcript.

Revisions, to heading where components of an utterance are changed, are broken down into number of part word, word, and phrase revisions. "The (pu*) doggie licked me" is an example of a part word revision. "The (cat) kitten licked me" is an example of a word revision. And a phrase revision is where more than just a single word is altered in the maze; An example would be if the speaker said "(the puppy) the kitten licked me."

The same breakdown is included for repetitions of part words, words, and phrases.

The next section provides information on filled pauses. Filled pauses are a pre-defined set of words such as um, and uh. The filled pause information is broken down into single word filled pauses such as "(um) I don’t know" and multiple word filled pauses where more than one filled pause is used. An example might be "(uh uh uh) I don’t know".
If we scroll down in the maze summary report, we can see the maze distribution tables. These tables break down mazes by percent of utterances with mazes, number of mazes by the length of the maze, or by the length of the utterance, and the number of utterances by the number of mazes they contain (SHOW each). So there are a lot of ways to examine the speaker’s mazing patterns. For example, if we look at the first distribution table, we see that 100% of Cyanna’s utterances that had 12 morphemes contained one or more mazes. The database mean shows mazing at only 50% of 12 morpheme utterances. Often you will see a pattern, the longer the utterance, the greater likelihood that it will contain a maze as a speaker is attempting more complex utterances.

So we will close this report and keep it in mind that mazes are an area of concern for Cyanna.

Let’s bring up another report from the analyze menu. Recall from the standard measures report that Cyanna had some difficulty with facility and rate, specifically pauses. So we will look at the rate and pause summary to investigate her pauses in more detail.

Click on the rate and pause summary from the analyze menu.
Here is the summary report. This report is from the analyze menu so there is no database comparison, just the values for the child (or the target speaker) and the examiner. The top of the report gives you information on rate heading; including the elapsed time of the sample, the total words, the utterances per minute and words per minute.

The second half of the report gives information on pauses. There is information on number of pauses, total pause time, and average pause time.

Pause information is given for the child point (or the target speaker) and the examiner point. There is also a breakdown of where the pauses occurred within the utterances. So, in this example, Cyanna had 8 pauses that were in the main body of her transcript and 4 pauses that were within mazes. She had a total of 12 pauses in the middle of her utterances totaling 43 seconds. Notice that these pauses averaged 4 seconds each. The examiner had no pauses within her utterances.

There is also information about pauses that occurred between utterances. In the transcript, a line beginning with a colon indicates a pause that occurred when there was a change in speakers. For example, maybe there was a pause after the examiner asked a question and before the child responded. A line beginning with a semi-colon point to semicolon indicates a pause that occurred without a change in speaker.

We can see that Cyanna paused both within and between utterances. This might lead us to believe that she is struggling with word retrieval or language formulation issues.

We can go ahead and close the rate and pause summary.
If there were any errors in the language sample, it is important that the "omissions and errors summary" from the analyze menu is reviewed. Open report from analyze menu.

Here we are presented with a dialogue box to select our speaker point, utterance base point, and how to format the report for line entries and spacing point. Typically we accept SALT's default settings. At this point I am only interested in the child or first speaker's errors and omissions, and I want to see them wherever they occurred. I will include the entry numbers so they are easy to go back and find within the transcript if I need to later on.

Go ahead and click “OK”.
In the “omissions and errors report” we see both the number of omitted words point and omitted bound morphemes point within the language sample. In Cyanna’s case she did not have any omissions.

Next we see the word-level errors found in her language sample. Cyanna had a total of 5 word-level errors point to total. The errors are listed and below, the errors are expanded by the utterance. This is helpful to get an idea of the context in which the error was made. Was it in the middle of a maze? Was the speaker struggling with word finding? Are there patterns of errors such as trouble with articles or pronouns?

The next section shows the utterance-level errors. These are the utterances that contained errors which affected the entire utterance, that had three or more word level errors, or which contained errors that could not be decisively marked with word-level error codes.

This report is really useful when talking to parents or other professionals about the language sample as you can easily give examples of the speaker’s errors and omissions.

You may remember from the Standard Measures Report that Cyanna abandoned 6 utterances and she interrupted the other speaker 2 times. Let’s look at these utterances.

From the Analyze menu, select “Standard Utterance Lists”.

In the “omissions and errors report” we see both the number of omitted words point and omitted bound morphemes point within the language sample. In Cyanna’s case she did not have any omissions.

Next we see the word-level errors found in her language sample. Cyanna had a total of 5 word-level errors point to total. The errors are listed and below, the errors are expanded by the utterance. This is helpful to get an idea of the context in which the error was made. Was it in the middle of a maze? Was the speaker struggling with word finding? Are there patterns of errors such as trouble with articles or pronouns?

The next section shows the utterance-level errors. These are the utterances that contained errors which affected the entire utterance, that had three or more word level errors, or which contained errors that could not be decisively marked with word-level error codes.

This report is really useful when talking to parents or other professionals about the language sample as you can easily give examples of the speaker’s errors and omissions.
This dialog box lets you select over twenty standard utterance lists.
Select “Abandoned Utterances”...

...and “Interrupted Utterances.”
We are only interested in Cyanna's utterances so keep the speaker setting at 1st speaker. Make sure the Utterance Base is set to "Total utterances" since these incomplete utterances are excluded from the analysis set utterances. Click OK to generate the report.

The abandoned and interrupted utterances are listed. It would be useful to see the utterances that preceded and followed these utterances.
Go back and select “Standard Utterance Lists” again.

Change the context to show 2 preceding...
Then click OK to generate the report.

This time the report highlights the abandoned and interrupted utterances in context. Use this report to look for possible patterns in these utterances.

There are many other reports available when analyzing samples. You should take time to familiarize yourself with their contents.

Hopefully, this tutorial was helpful with giving you a general understanding of the process of analyzing a language sample and how to generate useful reports for your interpretation.